
 

 
APPENDIX C -- USERS' GUIDE 

STRUCTURING A LITERATURE DATABASE USING PROCITE™ 
 
Viewing or navigating the ProCite™ database  
 

The ProCite™ software allows a user to change views of the database between a table of 

all records or an individual record. The individual record may also be viewed on a split 

screen, to show the workform plus the formatted reference like it would appear when 

cited or reported in a list. 

Figure 1. ProCite™ Database – showing Fields in a Record List  

 

The tabular or “spreadsheet” view will appear when a ProCite™ database is opened, 

presenting columns of data. Sorting may be done by clicking on a column heading. A 

“Sorting Database” pop-up box will appear to show progress for the sort operation, and 

the rearranged data will appear on-screen after the software has performed the sort. 

 

A standard view has been produced in the database, by selecting these fields in the 

following order for viewing:  
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Record ID number, Author, Date, Title, Rank, Compiler's Comments 

The database can be manipulated to order records alphabetically by author or by title, or 

numerically by date or by record ID number. 

 

The view can be changed, by going to View > Configure Record List > Record List tab, 

and selecting or deselecting from the check boxes and drop-down lists of fields. The 

order of the fields can also be changed, by retyping column headings into the template 

and using the drop-down lists to choose other fields to view. (ProCite™ allows only 6 

columns for viewing on-screen, however.) By un-checking the check boxes, fields may 

be “hidden” from view (for example the Record Ids or locations may be “turned off” in 

this way). Lines between columns can be resized just as in any spreadsheet or database 

viewer, by dragging the line pointers to where you wish them to be on the viewing 

screen.  
 

Searching: 

 

There are two ways to search a ProCite™ database. The Quick Search is activated by 

clicking on the “Go To Record” or spyglass icon on the taskbar, where a drop-down text 

box will appear and give options for common ways to search (such as by Author, Date, 

Title, or Record ID). The full Search is activated by choosing the Search tab at the bottom 

of the screen, and then specifying among the multitude of fields and operators, and by 

typing keywords into the text box and then hitting the Search button or Enter key on your 

keyboard. Results for each search will be displayed on-screen immediately. 

 

Further instructions may be found by using the Help feature within ProCite™, or through 

access to the database manual. 
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Figure 2. A ProCite™ Database  – showing Search capabilities 

 

Producing output (lists, bibliographies, subject groupings): 

 

ProCite™ will allow for the creation of various printed products, such as lists of 

references cited. Basically, this is done by first identifying the records wanted and either 

marking or highlighting and then grouping them based upon what is wanted. 

The simplest method is to perform a search, identify the records by using the Mark 

Selected or Mark List features on the taskbar, or by individually marking specific records 

by clicking on the box to the left of each one to select a subset. Next, go to the Marked 

Records tab at bottom of the screen, perform any sorting desired, remove by unmarking 

any unwanted selections. Then, go to File > Print Bibliography. A menu box opens, and it 

is here that you specify what is wanted in your output. You can Show All Records in List, 

Show Marked Records, Show Highlighted Records in the first drop-down selection box. 

The list may be saved as a file, or printed for proofreading, editing, or publishing. 
 

Also, you must specify Output Style from among numerous options on the middle drop-

down menu, and need to spend some time in selection among all the scientific journal 

options. Choose the Workform option if you want each record to appear in full; otherwise 

the 'ANSI standard' or the 'Chicago' styles are the most common and generic. If you need 

to cite in the Author-Date-Title format, with dates appearing before the title, you need to 

find a science title that does so, with punctuation according to your preference, or to 

select the pre-formatted 'Chicago B' style. The next button with three dots … selects the 
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full output styles that the ProCite™ software contains. The next option button (on the 

right) labelled “Configure” allows you to further specify in Reference List, Fields, and 

Page Layout templates many further options. Of special note on the Reference List tab is 

the text box allowing you to type a TITLE for your output pages. Some time and 

experimentation are required, before your final product is printable. You may then Print 

or Save to a word-processor file for further manipulation before printing. 

 

For publishable results, a customized output style may be necessary. See the 'Help' index 

and follow the directions provided within the software to pursue this option. Similarly, 

ProCite™ has a 'Cite-While-You-Write' option for including citations from the database 

and embedding or linking them directly into a word processor. Optionally, you can 

produce a printed bibliography, transfer it to a word-processing file, and perform any 

customization such as assigning a style, editing, or use the searching options (such as 

'Edit > Find' in Microsoft Word) if that is appropriate. Results and products can then be 

converted to HTML formats for web posting, as well. 
 

Opening Links: 

 

Within the database, you may also automatically open web links to the Internet, if you 

have a browser running at the same time that ProCite™ is running. Just double-click the 

link in the URL field, or if this does not work, you can cut-and-paste into your browser’s 

Location or Address window box, or click on the 

WebLink icon on the ProCite™ database taskbar. This should take you to the electronic 

document or link given in the database. 
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ProCite™ database structure 

 

The ProCite™ software (Version 5.0) provides up to 45 fields of data presented in 39 

different work-forms for bibliographic information, as follows:  

Workform Fields Figure A. Workform Template for Soil Quality Index Literature Database in ProCite 5.0. 

 
Record Number: Numeric, from 001 to 999. Exception: Alphanumeric, when one work is within 

another; e.g. a conference presentation published as one article within a 
proceedings, or one chapter within a compilation of related scientific papers on a 
topic or common theme, or one linked portion of a website. 

Author, Analytic: Main author responsible for a work, listed by: Surname, First name or Initial. 
Second Initial. Co-authors next listed in order they appear on the main title page. 
Separators in ProCite 5.0 are: two forward slashes between authors; Corporate 
author entries are preceded by an “equals” sign, so that they will format properly 
at output, as distinct from personal authors’ names. 

Author Role: This field is usually BLANK. 
Author Affiliation: Agency, institution, or workplace of author(s). 
Article Title: Title, entered in “title case” (i.e. First significant word is capitalized, as are 

proper names, followed by lower case for all words) of the article, presentation, 
or paper.   
NOTE: ProCite treats this field as the primary title for viewing.  
 

Medium Designator: N.B.: This field has been customized for use to indicate the RELEVANCE 
or significance of the article/paper/work in terms of the literature review 
project.   RANK = H, M, L, or 'u' 

Connective Phrase: This field is usually BLANK, but may state: “IN” if the article is from a 
collected work, conference, or compilation. Chapter number in a book will be 
given here if relevant. 

Author, Monographic: This field is used for the author of a book, editor of a proceedings or collection. 
Editor/Compiler: The field label appears as this if the workform is for a conference. 
Author Role: This field is usually BLANK, but may state: “Editor” or “Editors” where 

applicable. 
Editor/Compiler Role: The field label appears as this if the workform is for a conference. 
Title, Monographic: This field is used for books, and is the Main title field when a collected work or 

monograph is being referred to (as opposed to an “article”). Books have a 
separate workform, so most often this field does not appear in the record 
template, unless it is a book. 

Proceedings Title: Gives the name of the conference, congress, symposium, workshop, or 
proceeding, as it appears on the main title page. On occasions where a 
conference paper is (also) published as a journal article, the reprint is always 
treated as an Article and so should be given in that field and not in this one. 

Journal Title: Name of the periodical is given IN FULL (not abbreviated wherever possible). 
Use the drop-down menu to the right of the field for a full list of titles in the 
database.   

Report Title: This field is used for all scientific and technical, government, agency, or 
industry reports, and is preferred to the “Article Title” field when the item IS a 
report in and of itself, and NOT an article published in a journal or periodical, or 
an excerpt from the full report. On occasions where a portion, summary, 
revision, or synthesis of a report is published as a journal article, the reprint is 
always treated as an Article and so should be given in that field and not in this 
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one. 
Newspaper Name: Gives the name of the newsletter, newswire service, or newspaper or 

newsmagazine title where applicable, for news items and not for periodical 
articles.  

Source: This field stands in for, or replaces, the title field when the source is an 
Electronic Citation (workform). 

Date of Meeting: Gives the start date, dash, end day, Month, Year of a conference, if it was not 
listed in the Proceedings Title field above; and is omitted here if it was given 
above, to avoid duplication upon output from ProCite. This field only appears 
with a conference paper workform. 

Place of Meeting: Gives the location of a conference, usually city, state or province, and country(if 
applicable); and is omitted here if it was given as part of the title in the 
Proceedings Title field above, to avoid duplication upon output from ProCite. 
This field only appears with a conference paper workform, if in-filled. 

Reprint Status: This field is usually BLANK, but may report that an item is On Request, On 
File, or Not on File, and gives the Date of the entry of data into the record. 

Edition: This field is usually BLANK, but may indicate the date of a work, especially if 
it is an edition of a book or government publication that may have been revised. 

Author, Subsidiary: This field is usually BLANK. 
Author Role: This field is usually BLANK. 
Place of Publication: City, and State or Province (abbreviated to its two-letter international code) 

where the article or work was published. 
Publisher Name: Full name of publisher; if a government or country or institution or agency, the 

broadest or “highest” category is given first, followed by a comma, then the next  
level.  

Publication: Copyright date or official Date published, year only. (Months or days are given 
in the Notes or Edition fields, or under Issue if a periodical). 

Date of Copyright: This field is usually BLANK, but may state the year when the official copyright 
symbol © is present. In that case, precede the year by " c. " (without the 
quotation marks) or c period. 

Date of Access: Appears when the main title is for a Web Page workform 
Last Update: Appears when the main title is for an Electronic Citation or website workform. 
Volume Identification: Number of periodical or journal volume, when the article is in a journal or serial 

publication. 
Section: Appears when the “volume” is for a newspaper title workform. 
Issue Identification: Number and/or Date given when article is published in a journal or periodical. 

Format used was the number, followed by a space, and abbreviated month (in 
brackets) where provided on the source of information. 

Number: Appears when the “volume” is for a newspaper title workform. 
Page(s): Start page, dash, End page of article, chapter, and presentation in printed 

publication or work. This field does NOT give the total length of the work (see 
Extent of Work field below), but is reserved for where the specific pages 
consulted for the literature review occur inside the whole work, such as in a 
periodical or as a book chapter. 

Report Identification: Gives a report number where applicable. 
Extent of Work: Total number of pages, or volumes, of the whole work where given in the source 

of bibliographic information. 
Packaging Method: Use a “ p. “ to denote “pages” as in “ the total number of pages.” 
Series Title: Name of a publisher’s or agency series, such as “Technical Report” series. 
Series Volume ID: This field is usually BLANK, but may state the Number of the Report within a 

report series.  
Issue ID: This field is usually BLANK 
Connective Phrase: This field -- a second 'connective phrase' field, for series -- was CUSTOMIZED 

FOR THE SOIL QUALITY INDICES LITERATURE PROJECT, to hold 
"Compiler's Comments". 

Address/Availability: Where to locate a copy of the article or book. AAFRD + Alberta Agriculture, 
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Food & Rural Development Library; NEOS = Edmonton Library Consortium; 
CISTI = Canadian Institute of Scientific and Technical Information; CAL = 
Canada Agriculture Library; c&d = Conservation and Development branch files. 

Location/URL: If Conservation & Development Branch of AAFRD has a copy, then this 
appears as “c&d”. May also contain notes such as “On Request" or “AAFRD 
Library”. Always shows the URL if the item is available on the 
Internet/WorldWideWeb. 

CODEN: This field is usually BLANK; not used. 
ISSN: International Standard Serial Number is given in this field; for periodical titles. 
ISBN: International Standard Book Number is given in this field; for book or report 

titles. 
Notes: SQ Index Literature Review Project -- Information provided:  

� Record downloaded from [database name and Date]; OR,  
� Reference cited in: [Title of Source article or publication, Author(s), Date: 
Page range]; OR,  
� Citation provided by AESA program staff.  
� Any bibliographic notes. 

 A Table of Contents listing is included when important to this project. 
Abstract: Usually gives the Author(s) Abstract, included when important to this 

project, as all words are searchable within ProCite. Descriptive abstracts are 
useful for the information they can provide concerning research or literature 
analyses. The “author abstract” note with page number are given in italics, to 
denote that the abstract was, indeed, provided by the author or search service. 
Abstracting services are acknowledged here. 

Call Number: Given when provided during searches, in order to locate the literature. DNAL = 
designation for the US National Agriculture Library classification; AEAG = 
code for the AAFRD Library within the National Library of Canada's 
classification system for Interlibrary Loans. 

Keywords: Subject-analytic terms, classification of the soil quality assessment literature, 
author(s)’ recommended terms when given, search engine descriptors and 
identifiers when the citation has been downloaded from literature indexes and 
search services or library catalogues’ subject headings used to describe their 
holdings. Use the drop-down menu to the right of this field for a list of the 
subjects in the database.  

The most commonly-used workforms for this project were Journal Article, Report, 

Conference, Book Chapter, Book Short form, Generic, Web site, and Electronic Citation.  

If a “default” is needed, prefer to use the Journal Article template. 
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